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1. ACCESS TO THE PPP TOOLS – GENERAL INFORMATION 

Two versions of the PPP database exist.  

The acceptance server contains a copy of the PPP database and it is used for testing new versions of 

the tools and for training: https://webgate.acceptance.ec.europa.eu/ppp_tool/. 

The production server contains the real PPP data: https://webgate.ec.europa.eu/ppp_tool/ 

Please login with your EU Login1 user id and password. 

After login, select your role e.g. COUNTRY (country 2-digit code). If access to the PPP tools is 

restricted, contact the Eurostat PPP team ESTAT-PPP@ec.europa.eu to assign your user to a specific 

role in the PPP tools. 

After login the homepage of the PPP database opens. From here, you have direct access to all PPP 

tools listed below. 

PPP Tools: 

 Item List Management Tool (ILMT) 

 Price Collection Tool with link to Data Entry Tool (DET) 

 Metadata Editing Tool (MET) 

 Validation Tool (VT) - includes Survey Archive 

 Aggregation Tool (AT) with Aggregation, National Accounts Data, Auxiliary Data Tools 

This short manual aims to provide information about the use of the online Metadata Editing Tool. It 

gives an overview and understanding of the features of MET, instructions that help to draft and 

provide the survey report. 

Eurostat presented a proposal to integrate the compulsory survey reports for consumer goods, 

equipment goods and construction surveys into the PPP Database and PPP Validation tool, proposal 

endorsed by the PPP Working Group in 2016 (Doc. 16/P2/10). Following that proposal, an editing tool 

was developed. In order to ensure a straightforward and easy to use tool, a set of minimum 

requirements was established and this gives the main description of the Metadata Editing Tool: 

 enter the information in an easy way, similar to other editing tools 

 option to use text mark-up (e.g. italic font, formatted lists), tables; 

 option to use copy/paste shortcut and other common shortcuts; 

 option to attach files; 

 restrictions regarding the draft versions of the report (drafts available for the country 

only); 

 option to export different versions of the survey report. 

 

                                                            
1 EU Login is the European Commission's user authentication service. It allows authorised users to access a wide 

range of Commission web services, using a single email address and password. 

https://webgate.acceptance.ec.europa.eu/ppp_tool/
https://webgate.ec.europa.eu/ppp_tool/
mailto:ESTAT-PPP@ec.europa.eu
https://circabc.europa.eu/d/a/workspace/SpacesStore/c039c618-80db-4d34-ab3f-cbda0eb6ede4/16-P2-10%20Integration%20of%20survey%20reports%20in%20PPP%20tools.pdf
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2. METADATA EDITING TOOL 

2.1. General information 

The online Metadata Editing Tool (MET) is accessible from the PPP Tools – Homepage. A link to 

the survey conducted in that period and its report is displayed here. 

 

One click on the survey name will re-direct you to the MET and the survey report.  

If the report is created for the first time, the following pop-up window will appear informing about the 

creation of the initial report. 

 

Otherwise, the survey report will open in MET.  

In MET, you can navigate through reports of different surveys, if available; navigation is done through 

the survey-tree (see section below). 

2.2. Explore the tool 

 Selection panes 

 Operation area 

 Menu area 

 Work area 
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The tool has a structure similar to ILMT and VT, namely the screen is divided in four areas: the menu 

area on the top, the selection panes on the left side, the operation area where information is displayed 

according to the selections made and the work area on the bottom. 

 Selection panes 

The selection panes allow to select any of the surveys and any of the survey years – for this click on 

the 1st panel from the top; and to select any section and subsection of the report - click on the 2nd panel. 

Click on the  to expand the tree; and on  to collapse the tree. 

 

 

 

The name of the sections and subsections of a report are 

displayed in the survey-tree in the left side pane. The following sections2 are available in a report: 

1. Pre-survey 

2. Price Collection 

3. Intra-Country Validation 

4. Inter-Country Validation 

5. Specific questions related to the Survey 

 

The section ‘Inter-country validation’ may be completed once the validation is closed. 

 Operation area 

The operation area shows the information according to the selection made in the survey tree or menu. 

This is also the editing screen and it includes a rich text editor (see section 2.3.2). 

  Menu area 

Submit  Edit (View tab) 

New version  Upload (View tab) 

Export  Save (Edit tab)  

Help  Cancel (Edit tab) 

The MET menu includes operations that allow the user to submit3 the survey report, to create on 

request a new version of the report, to export the document as well as a Help that offers information 

                                                            
2 Standard format for consumer goods surveys 
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about the MET tool, the user guide and the PPP Manual. Below the main menu, there are two tabs 

displayed, one showing the report with a sub-menu available, Edit and Upload, and one showing all 

the existing versions of the report.  

 Work area 

The work area is displayed at the bottom and operations like Upload will be managed from here.  

2.3. TABs: View, Edit, Report Versions 

 

2.3.1. View Tab 

Select one sub-section. Click on the View tab and a short description of expected information will be 

displayed in the upper side of the screen. In the example below the sub-section 1.2 Sources of 

information of section 1 Pre-survey is selected. 

 

A sub-menu is displayed within this tab with two actions: Edit and Upload. 

2.3.2. Edit Tab 

Choose the sub-section (question) from the left panel (see selection panes in section 2.2) and press the 

Edit button. The Edit tab appears with the editing screen as well as an editing menu (HTML editor).  

 

                                                                                                                                                                                          
3 Functionality not yet available as of May 2018 
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The HTML menu includes the following commands: 

 Undo (Ctrl+Z) 

 Redo (Ctrl+Y) 

 Link (Ctrl+L) 

 Unlink 

 Anchor 

 Table 

 Insert Special Character 

 Bold (Ctrl+B) 

 Italic (Ctrl+I) 

  Underline (Ctrl+U) 

 Strikethrough 

 Subscript 

 Superscript 

 Remove Format 

 Insert/Remove Numbered List 

 Insert/Remove Bulleted List 

 Decrease Indent 

 Increase Indent 

 Paragraph Format (drop down menu) 

Start typing your text in the area under the HTML-menu and use the commands or keyboard shortcuts, 

when available, to format the text (see above the list with shortcuts). No specific instructions are to be 

followed to encode your text as this is a simple editor, therefore just type the text in the designed area. 

If you have to copy an amount of information from another application in a specific sub-section, use 

the common copy/paste (Ctrl+C/Ctrl+V) commands. 

Note that the editor allows the use of text mark-up, formatted lists, tables etc. 

In the Edit tab, a sub-menu is available with two actions: Save and Cancel. 

Press the Save button once you finished editing one question (sub-section). Failing doing this before 

you exit the editing area of a specific sub-section will cause the loss of the information. To avoid 

this, a pop-up window appears each time you exit the editing area of a section without pressing Save 

or Cancel. If you wish to save the information and not to lose any unsaved data, choose No when 

confirming the close of the editor and press on the Save button. 

 

The Automatic Save functionality is active and automatically saves the information every 10 minutes.  

Several users can work on a survey report, however, one sub-section can be edited by one user at a 

time only. Once that user saves (or cancels) the work, hence once the Edit tab closes, another user can 

start editing that sub-section. 
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 Upload 

In the View tab, next to the Edit button, the Upload button is available. Press on it to upload annexes, 

if any. Note that the Upload button is not available in the Edit mode but in View only. 

The below information is displayed in the Workarea allowing the upload of files less than 200 KB. 

 

Press on Choose File to select the file you want to upload. Then press on the Upload in the Workarea 

to finalise this step. To upload more than one file in the same sub-section, repeat the step described 

above (multiple selection is not permitted) or upload an archive (e.g. zip file). 

The attachments will be displayed in the operation area but below the editing area. 

 

To download one of the uploaded files, click on . To remove any of the attached files, click on

. 

2.3.3. Report Versions tab 

The Report Versions tab shows all available versions of your report, both submitted and not 

submitted, if any. 

Note that a report becomes visible to other countries only when submitted in the MET, and only the 

latest version of the submitted report is visible. 

For example, if together with the survey data you are submitting a part of the report (sections 1-3&5), 

this will be visible to all countries in the VT. When the report will be updated with the missing part 

(section 4) and the report will be submitted once again, the VT will display the latest updated version 

only. Hence, in VT, one version per country is available. 
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View from MET  

 

All reports (draft or any submitted versions) are displayed in MET in the report versions for a specific 

country.  

Click on to export a version of the report. Click on  to delete a version. You may delete any of 

the draft versions but none of the submitted ones, a message will be displayed when trying this.  

Note that all the information is stored in the database. If there are 2 transmitted versions and e.g. 10 

drafts that will not be used anymore, please consider their deletion. 

2.4. Actions in the Main Menu 

 

Four actions are shown in the main menu: Submit, New Version, Export, Help. 

 Submit 

Press on Submit to send your report to the Validation Tool. Later on, this action will also send the file 

to eDamis4. However, as this functionality will become available later, country should export the file 

and send it via eDamis using the standard dataset. 

Pressing the submit button, the below pop-up window appears.  

 

Once you press Yes, your survey report will be available in Validation Tool next to the price data. 

 New Version 

This function allows you to create a new version of the report. 

Once you have submitted a version of the survey report, you cannot edit that version. However a new 

version which is a copy of the last submitted one can be created. 

Also, it can be that during your work, you want to create a new draft version of the report eventhough 

you have not submitted the existing one.  

                                                            
4 Current version of the MET does not support direct transmission to eDamis. Instead, country should export and 

then send the file to eDamis using the standard dataset. 
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In both cases, a new draft can be created by pressing the function New Version from the main menu. 

The below pop-up window appears asking you to confirm the creation of a new report which is a copy 

of the latest existing version. 

 

Note that all the information is stored in the database. If there are 2 transferred versions of the report 

and e.g. 10 drafts that will not be used anymore, please consider their deletion. 

Sending a new version to VT will overwrite the existing published document. 

Section 4 Inter-Country Validation 

To  be  filled  after  the  validation  process  as  an  update  of  the  earlier  version  of  the  survey  

report. 

Use “New version” to open the survey report and to complete the section 4; as indicated in the 

description, this section is provided after the data validation. Just create a new version, fill in the 

information and resubmit your report.  

 Export 

Click on Export to obtain the file with your latest report. The output is an html file. Note that html files 

can be opened with web-browsers as well as with other tools (e.g. Word, Excel).  

 Help 

Here you find information about the version number of MET, a link to the user guide and to the PPP 

manual. 

 

3. SURVEY REPORTS IN THE VALIDATION TOOL 

Survey reports for each country will be available in the Validation Tool once they are submitted and 

each user will be able to see the latest submitted report of each of the other country.  

A new tab has been inserted in VT in the validation round of the corresponding price survey for this 

purpose and placed next to the BH SAFs tab. 

 

Besides the tab, the new Survey Report pane that provides the survey report tree is included among the 

other panes. 
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 This tree serves as a navigation mechanism through the sections of the survey reports, e.g. 

a user can select a chapter/section from the tree in order to view further details. 

 

Survey reports tab 

To summarize, select the pane Survey Report, select a question from the tree. As result, a grid view 

with following columns will be displayed under the Survey Reports tab: 

 Country 

 Code 

 Metadata Question 

 Comments 

 Show Metadata 

 Select 

 

From this view you can see and add comments and view the provided information for a single country 

or view side-by-side responses for several countries. 

 Country 

This column includes the 2-digit country code. The code contains a link, click on the country code and 

the metadata editing tool for the current SR will open in a new window. 

Sorting and filtering may be used for this column. For sorting countries’ codes, click one or two times 

and countries will be sorted in alphabetical ascending or descending order. For using the filter, type 

the letters in the white box displayed below the column header. 

 Code 

Here you can see the number of the question (sub-section). 

 Metadata Question 

The name of the question is displayed in this column. 

 Comments 

Comments, questions, answers can be added to any of the survey report sub-section. This is similar to 

the questions addressed in the Validation Tool to the price data and the answers and resolution 
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comments. In the Survey Reports tab, the comments column includes the balloon symbol in one of the 

following stages:  

-  White: there is no comment, question, answer 

-  Black: there is a simple comment for that section 

-  Red: There is an open question 

-  Blue: The question is answered 

-  Green: The answer was evaluated 

Click on a balloon to include your comment. Coordinators can use these balloons to add questions, 

evaluate the answers or just add simple comments. Countries can enter their answers or comments (see 

section Task Report below).  

A filter is included for the comments column that allows the user to select in a specific section for 

empty, simple (comments), question, answer, resolved comments.  

A similar filter is available in the Task Report pane (see section 1.6 Task Report) 

 Show Metadata 

Click on the symbol  in this column and a pop-up window will be displayed. The symbol appears 

in each country-row. Choose one row/one country and the information displayed in the pop-up 

window is the answer of that country for the question you have selected from the survey tree. 

 Select 

This column allows you to select several countries and to visualise information provided by them for a 

specific section.  

Selection is done by checking the radio buttons displayed here. Note that you can opt for a limited 

number of countries, selecting a large number of countries would reduce the good visibility of the 

information displayed afterwards.  

Make your selections then click on the  button displayed in the main menu of the 

Survey Reports tab. A new window will appear displaying the section (question) and the information 

provided by selected countries.  

In a next version of the tool, an export of the displayed information will be available. However, the 

export for all content of the survey report can be downloaded (see section Reports). 

 

Besides the specific tab, survey reports related information is on Reports available in the main menu 

and Task Reports pane. 
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Task report 

Select the task report either by directly selecting the pane displayed in the left side or by going to 

Reports and opt for Task report. From the pane, in the section Task report for: choose Survey 

Reports. 

 

The standard columns in the Q&A Report Sheet will show the country code, code of the section and 

the label of the question. The balloon symbol will indicate if a comment, question, answer, resolution 

is included.  

The exports features available in the Task Report pane here allow you to get: 

 the list with sections having a comment. Click on  

 the list with sections and comments. Click on the first or second pictogram  available in 

the Q&A Report Sheet to get the information in Word or Excel format. 

Press on Refresh  to update the Q&A grid, and on exit  to close the task report view. 

 

As mentioned earlier in the Comments section, a filter is implemented here too and allows you to filter 

for Questions, Answers, Resolved (resolution), Simple Comments. 

By clicking on the balloon here or clicking on the corresponding balloon in the Survey Report grid 

view (Survey Reports tab - Comments Column), further information will be displayed in the 

Comments pane.  

The structure of the task report is similar to the one of price data survey.  

Two boxes are displayed, one contains the comments history and one is the editing box - add your text 

here.  
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Once you’ve added your text, either a comment or answer or else, select the type of your text - Simple 

Comment, Question, Answer, Resolution - if other than the default one displayed. The type displayed 

as default differs on the user profile as well as the type of the previous comment, if question, answer 

etc. Press on the Save button to actually send your reply, otherwise on Cancel. The Delete button if 

pressed will apply on the latest insert from the Comments History Box as long as you were the sender. 

In order to add an information (either question, comment or else) to a specific section of the survey 

report in the Validation Tool, assuming that there is no previous comment on the section, select the 

section from the survey tree and click on the empty balloon from the Survey Reports Grid View. 

 

Adding a text via the balloons will add the information in VT only. If you want to add the information 

directly in the survey report, this shall be done in MET. If proceeded in this way, do not forget to re-

submit the new SR version so that it becomes visible in VT. Here the information provided via the 

balloons will remain available even if the SR is updated (e.g. Q&A will not be overwritten). 

Reports 

Go to main menu of VT, Reports section. Besides the Task Report action included here (see section 

above) there is the Survey Report(s). 

 

 

This action allows you to export reports of all countries selected in the countries tree. The export is an 

html file. If wished to visualise the document in a different format, save the file on your computer then 

open it with a different application (e.g. Word, Excel). 

 

4. CONTACT – USER SUPPORT  

Eurostat PPP team: Estat-PPP@ec.europa.eu 

Agilis (Report a problem/bug): ppp-helpdesk@agilis-sa.gr 

Estat-PPP@ec.europa.eu
mailto:ppp-helpdesk@agilis-sa.gr
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